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Module 6: Fortran

+ ODbjective
+ Learn what Photran is and how it compares to CDT
+ Learn how to create a Fortran MPI application
+ Learn about refactoring support

+ Contents
+ Overview of Photran
+ Module 3 redux (in Fortran)
+ Differences between Photran and CDT
+ Pointers to online documentation for Photran
+ Refactoring support

Module 6
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module Mdataset

[+]
implicit none |:|EI + 4} Mdataset =
) = W Tdataset
! Declare a Tdataset type to hold data points
type :: Tdataset ¥ datapt
real i datapt(4, 1068) = npts
integer i1 npts .
real s: walsum(4) walsurm
real i wvalsum(4) @ yalsum
real DooMysum(3) -
logical :: has np(2) Xysum
end type Tdataset ® has np |
end module Mdataset v {J BstFitProj

program BstFitProj

Photran

* http://www.eclipse.org/photran

* Official Eclipse Foundation project;
part of the Parallel Tools Platform (PTP)

use Mdataset

Problems &2 Console | Properties

@ Derived type definition has no compone] Supports Fortran 77’ 90, 95, and 2003
® * Built on CDT; largely similar to it

@ FILE tag must be of type CHARACTER

@ lllegal preprocessor directive

* Primary contributor: UIUC

T+ |(e]

* Contrib’s from Intel, IBM, LANL, & others
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Fortran
Editor &
Outline

ge-features

+ @ =src-line-fitting
i 0 S1] ) L
4 .cwsignore 1.1 {ASCI

P % src-modules

(] I

=

I T e e 3 T T laz }\‘\. “tzf e -
_module Mdataset B!
implicit none |:|EI = iyb Mdataset
. = ) Tdataset
! Declare a Tdataset type to hold data points
type :: Tdataset ¥ datapt
real i datapt(4, 1068) = npts
integer i npts o
real :: walsum(4) valsum
real tiovalsum(4) @ yalsum
real DooMysum(3)
logical :: has np(2)
end type Tdataset ¢ has np

?  xysum

=~ 4 BstFitProj
¥  LoadDataSet

L)

end module Mdataset

program BstFitProj )
ShowDataPoints

use Mdataset [~ “  sqguareDistances |7

| I | (€T T [+)

(&) Make Targets 3 = B ||[Z! Problems X . Console|Properties = ¥ =0

5 26 errors, 0 warnings, 0 infos

P = org.eclipse.photran-samples

P == whatever2

Description Resource [4]

@ Derived type definition has na components bug138221.f|:|

@ FILE tag must be of type CHARACTER buglleov4a.f
@ lllegal preprocessor directive bug118961.fE]




Module 6

‘[F] hello.f 7

ixed format source with
integer :: if = 3
integer :: end = 5
character :: endif =

if (if .gt. end) then
print *, &

Bendlf

endif

e 4
Era—

"Hello™

Context-
Aware
Highlighting
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> € Binaries Support ¢ datapt

[ sre-fixed-form (4,1800) ® npts

I -
1 src-fortran-and-c T ——arsom (4) valsum

- _ real troXysum(3) °
|47 src-includes logical :: has np(2) Kysum

P>
P
b (# src-gaussian-elimination real Li.vatsumid) @ wvalsum
P>
P

3 src-language-features end type Tdataset ¢ has np
< & >src-line-fitting end module Mdataset v () BstFitProj

™~ st i = ¥  LoadDataSet

program BstFitProj @

4 .cwsignore 1.1 {ASCI ShowDataPoints

P (3 src-modules use Mdataset [+] %  sguareDistances |*)
(4] I I D] (ol _w ] D

—+|, VEIE

(® Make Targets 22 = 0O [Zi Problems X . Console| Properties L

5 26 errors, 0 warnings, 0 infos

- ) Description Resource [4]
[ 1= org.eclipse.photran-samples . . —

P whatever? @ Derived type definition has no components bug138221.f|:|
@ FILE tag must be of type CHARACTER buglls9va.f
@ lllegal preprocessor directive bug118961.fE]

[+)




Eile

HR Fortran Projects 52 = 8 e = O | 5= outline 2 =8

= q}'{b - I T e e 3 . T laz }"ﬂ h&s a
— _module Mdataset Ial

P EEMMFP ol implicit none DE = ) Mdataset

— WP Tdataset

L

~ h_'jcn-org.eclipse.photran-samp
! Declare a Tdataset type to hold data points

P < Binaries type :: Tdataset
[ src-fixed-form .real :: datapt(4,1000) % npts

integer lonpts

[ src-fortran-and-c real - - yalsum(4) “  walsum

datapt

- _ real troXysum(3)
|47 src-includes logical :: has np(2) Kysum

3 src-language-features end type Tdataset ¢ has np

P>
P
b (# src-gaussian-elimination real Li.vatsumid) valsum
P>
P

v G >src-line-fitting BstFitProj

end module Mdataset

B =phst i 7S LoadDataSet

) program BstFitProj
4 .cwsignore 1.1 {ASCI

P (3 src-modules use Mdataset

(] I I

(® Make Targets 22 = 0O [Zi Problems X . Console| Properties

5 26 errors, 0 warnings, 0 infos

- ) Description
[ 1= org.eclipse.photran-samples : .

P whatever? @ Derived type definition has no components
@ FILE tag must be of type CHARACTER buglls9va.f
@ lllegal preprocessor directive bug118961.fE]
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4+ Debug - sayhello.FA0 - Eclipse Platform

File Edt [Mavigate Project Run  Window Help

~=.n| o1 Jf} - - J"‘u—‘ - K J ¥ R D’|f}Dehug HFjFortran

4 g
%% Debug 52 = O ||td=variables i2 “_Breakpo... | Regiskers » =0
&5 b O 3 T @ | i -

= 5F SayHello-Photranz, 1-win32-g35 [Fartran Local Applics = ¥ language
EI Cyigwin GDB Debugger (2/15/05 11:32 AM) (Suspe
. E Thread [1] (Suspended)
= 3 speak_ 4740 at sayhello,fa0:56

= ZM.ﬁ.II'i.I_{} at sayhello.Fo0: 71 _r|;| Debugglng
(GDB GUI)

call RANDOM HUMBER (rand)

if (rand > .7) then
language = 'Greesk!

else if (rand > .3) then
language = 'Folish!

el=e
lanoguage ''Japanese'
end if

1
S

"B console 53 _Tasks ] | B | = B -=0

o)

SavHello-Phokranz, 1-win32-g95 [Fortran Local Application] Debugger Process (21505 11:32 AM)

Foygdrive/ o/ WINDOWS/ system3Z/ / kerneldz . dll

Fovgdriveo/Docuwents and Jettings/draganch/Desktop/eclipse/workspace/ JayHel L
Fovgdrive// o/ WINDOWS/ system3 2/ advapidz . dll

Wiritable amark Insert | g6 1
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Installing Photran

http://wiki.eclipse.org/PTP/photran/documentation/photran6#Installation_Procedure

+ You will need a Fortran compiler
(e.qg., gfortran), make, and gdb to Available Software

Complle & debug Fortran programs Check the items thzt you wish to install.

+ From the Help menu, choose
Install New Software...

+ Select the Helios update site

Work with: | Helios - http://download.eclipse.org /releases fhelios :_1 Add...

Find mora software by working with the “fvailable Software Sites

. Photran

Mame Version

+ Under Programming Langs [T
Check Fortran Dev. Tools |y
+ Click Next
+ Finish installing: —_—
+ Next, Accept license, Finish Photan - An Eclpse-based Integrated Devslopment Environment

o 0o W Show on y the latest versions of available software [ | Hide items that are already insta
+ Features and prereqUISIteS Iv* |"} aun l .-jll-,_l. CZTROOryY r - et e | j :
are downloaded and installed...

+ Restart Eclipse when prompted
Module 6

{ selectall ) ( Deselectall ) 1item selected
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Using Photran

+ It's just like using CDT...
+ Similar New Project wizards
+ Similar build procedure
+ Similar launch/debug procedure

+ ...but not exactly
+ Remote development not supported
+ Configuring fixed vs. free form file extensions
+ Different editor features
+ Different advanced features (Module 7)

Module 6 6-10
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Fortran

Switch to @/ 0+ Perspective

(same as for C/C++)

+ Only needed if [Window [T
you're not New Window

already In the
perspective %5 Debug

Sh::-w View &Y Team Synchronizing

Customize Perspective... Dther...
Save Perspective As...
Reset Perspective... HgC/C+
Close Perspective 7 CV'5 Reppsitory Exploring

; Close All Perspectives Deh

+What Perspective 7 Debug
g Navigation B #2 FindBugs
am in in?

%JJM:L {default)
e | .
oo Java Browsing

See Title Bar
SO

Fortran 9 Eclipse SDK § _
~—— _ |:;:JJ.1-.r:L Type Hierarchy

Bk - By Qv @y [ [Fi» &y Fv | O~ | | =Plug-in Development
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Creating a Fortran Application

(same as Creating a C/C++ Application)

Steps:

+ Create a new Fortran project
+ Edit source code

+ Save and build

& Fortran - Eclipse SDK

[ File | Edit Mavigate Search Run Project Window Help

Mew Alt+5Shift+M » | [f] Fortran Project

Dpen‘h... 1 Project.. \

Module 6 6-12



paraiiel t1oo

New Fortran Project Wizard

(similar to New C/C++ Project Wizard)

[ N ) Fortran Project

Create a new MPI project
+ File»New»Fortran Project

Fortran Project

Create a Fortran project of the selected type

(See preV. Slide) Project name: _I\.‘--,rriel-:JF'-'u:-jr:ct
+ Name the project e —
‘MyHeIIOPrOjeCt, Choose file system: rauit There are
+ Under Project types, under e ;T;gi?:?ofu”d"
Makefile Project, select MI_DI Fortran too..
Hello World Fortran Project e (G foran on wscos ) | |
and hit Next cutable (el Fo i ...but this is a
_ ] e e .| Makefile project,
+ On Basic Settings = where you
page, fill in information Srelowscopoee (| maintain the
for your new project E—— | | Makefile

(Author name etc.)
and hit Finish

Finish )

Module 6 6-13
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Fortran Projects View

(similar to C/C++ Project Explorer view)

+ Represents user’s data

+ It is a set of user defined
resources

+ Files
+ Folders
+ Projects

4+ Collections of files and
folders

+Plus meta-data

+ Resources are visible in the
Fortran Projects View

Module 6

E Fortran Projects 53

> -.'l-;-,[::' Binaries

P [l Includes

¥ [ src

> ﬂ MyFortranProject.f90

P = bin

6-14



Editor and Outline View

4+ Double-click on
source file to
open Fortran
editor

4+ Outline view is
shown for file In
editor

(similar to C/C++)

SO Fartran - MyHelloProject/src/MyHelloProject.f30 - Eclipse SDK

[=sh = | & é&j hﬁv %&7 Q- G-q-

) Fortran Pr 52 = B || [F] MyHelloProject.fa0 53

& =

S

E':;-NyHel'Oanject

b use mpi
5 Binaries

implicit none

integer, parameter ::

» [F] MyHelloProject.fg0 )
¥ (= hin :.nte_qer
.Ccproject :.nteger

= .prcueu;t integer

integer
integer

@ Mak

integer

B~ 69~ [~ | O-

11 source
11 dest

: taog
character(len=LEN) :: !
11 stotus(MPI_STATUS_SIZE) |

message

€

)

[%1 Problems 23 ]l console| [, Fortran Declaration

0items
Description

L5

& |Resource

H Eﬂ:ﬂran
EE Qutline 3 =8

a 5 e ~
2R o %
<Free Form Scurce >
¥ [(anonymous)

VI:IE

Location

Writable




paraiiel t1oo

Build

(same as C/C++)

+ Your program should build when created.

+ To rebuild, many ways include:
+ Select project, Hit hammer icon in toolbar
+ Select project, Project » Build Project
+ Right mouse on project, Clean Project

Bun BAPI Window Hel

Close Project

o Build All Ctrl+B
Build Configurations >
Build Project
Build Working Set
Clean...

7 Build Automatically

New

> " Binaries ]
Go Into

P g Include:
b @@ src Open in New Window

< = Debug = Copy
P = src
MyH ¥ Delete
& Mmake

Make Target

Properties

psourq  Rename..

g4y Import...
5 Export...

Clean Project

Module 6 & Refresh 6-16

Close Project




in the Debugger tab)

Module 6

Et Cetera

+ Creating a launch configuration is identical
(Suggestion: Uncheck Stop on startup at main

= Run Configurations

Create. manage. and run configurations

+ Application
clipse Application
Fertran Local Application
[F] FortranOnWindows Dv
ra Applet
ra Application
Ju JUnit
1 JUnit Plug-in Test
= Launch Gro
4+ 05Gi Framework

4 e

Filter matched 10 of 10 items

MName: FortranOnWindows Debug

] Main . 9= Arguments | B Environment | ™
Fortran Application:

Debug/notepad.exe Search Project... | | Browse...
Project:

FortranOnWindows | Browse...
Build (if required) before launching
Build cenfiguration: | Debug

Enable auto build Disable au

@ Use workspace settings Configure W

Close |

6-17
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Et Cetera

+ Debugging is identical

+ Launching a parallel application is identical

+ Debugging a parallel application is identical

Module 6

6-18



paraiiel t1oo

Diagnosing Common Problems

(also true for C/C++)

Building: Are compile errors
not shown in the Problems
view?

+ Right-click on the project
in the Fortran Projects
view, and choose
Properties

+ Expand Fortran
Build » Settings

+ Switch to the Error
Parsers tab

+ Are Photran’s error parsers
checked? If not, click
Check all

4+ Click OK and re-build

Module 6

Launching: Is a binary not

listed when creating a launch

configuration?

+ Right-click on the project in
the Fortran Projects view,
and choose Properties

+ Expand Fortran
Build » Settings

+ Switch to the Binary
Parsers tab

+ Make sure the parser for
your platform is checked
PE = Windows

Elf = Linux
Mach-O = Mac OS X
4+ Click OK

6-19
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Differences (1): MPI Project Wizard

+ In the MPI Hello World C Project (local project),
the MPI compiler is set in the project settings...
(Local, managed build project: see Module 7, Advanced
Features)

+ ...but in the MPI Hello World Fortran Project,
the MPI compiler is set in a Makefile.

& Makefile 3
. PHONY :

src/MyHelloProjact. £98

clean:
rm -f bin/MyHelloPraject *. mod

Module 6 6-20
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Differences (2): Content Assist

+ Content assist is disabled by default.
(So are Declaration View, Hover Tips, Fortran Search, &
refactorings.)
You must specifically enable it for your project.

- -
+ Right-click on the = ; o

- - X Analysis /Refactoring Sy corw
p rOJ eCt I n the Fortran A _— To enable Open Declaration, Find All Referemces, the Fartran DEcllar'ati-:nr\
- - view, conten ; in Fartran programs, check the
P rOJ eCtS VI eW, a.n d > Byl :-_ 1:-' | ] E_-l (index} '.'-'illphegupdated every time
choose Properties
+ Expa’n d FO rtra'n > p :- l E‘ Emable Fortran content as :'-i:t-li:;trl+5pa|:&]
Analysis/Refactoring e Sondrgs | 15 Enable Forran Hover ups
+ Check Enable Fortran e B s ety o
analysis/refactoring your compler o build you

+ Click OK
+ Close and re-open any
Fortran editors
Module 6
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Differences (3): Source Form

+ Fortran files are either free form or fixed form;
some Fortran files are preprocessed (#define, #ifdef, etc.)
+ Determined by filename extension
+ Source form is set in the project properties

+ Defaults:
Fixed form: .f Fix for fpp ftn 77
Free form: .f08 .fO3 .fo5 .fo0 < unpreprocessed

.FO8 .FO3 .F95 .F90 < preprocessed

+ Many features will not work if filename extensions
are associated incorrectly

(Outline view, content assist, Fortran Search, refactorings,
Open Declaration, ...)

Module 6 6-22
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Differences (3): Source Form

Set free/fixed form associations in the project properties

. & ) - Properties for org.eclipse.photran-projects.collections
+ Right-click a project EFEEEEEEETET
i n th e FO rt ran g R'_-:'E-GLI”:.E The list of Fo 1

B C/C++ Build hy tke

Projects view C/Chs Genera

+ Click Properties

Free Form - C Preprocessed

Free Form - O

+ NaVIga.te the tree to ;u:,..' o ..__:. I__':-_.__5 *F77 .Fi:-::a':d Farm
Fortran General » o
Source Form e —

ixed Form — INCLUDE line

Free Form - C Preprocesse

+ Select SOU rce fo r-m l. ixed Form - INCLUDE lines

ixed Form - INCLUDE lines ignore

for each filename
eXte nS i O n 3:3 Free Form

Free Form

Fi:r.::r:d Farm -

+ Click OK

Module 6 6-23



Differences (3): Source Form

Add new filename extensions in workspace preferences

248 File Edit Refa
About Eclipse SDK

U Preferences

Preferences...
Content Types

viGeneral

i i B Appearance

Hide Eclipse SDK Capabilities Content types:

Hide Others \ Compare, Patch

Show All Content Types

pEditors

Quit Eclipse S5DK Keys

See 'File Associations' for associating editors with file types.

pEBinary File
Java Class File
TText
Assembly Source File
b MNetwork Connections » C Source File

Perspectives Fortran Source File

+ Navigate the tree search » JAR Manifest File
P Security b Java Properties Efe

tO General > b Startup and Shutdown
Content Types Web Browser

FWorkspace *f (locked)
v ANt *f03 (locked)

Expand Texthy v Editor 08 (locked)

Content Assist * 77 (locked)

Fortran Source Formatter * £90 (locked)

1 Templates * §O5 [ i
File 2mp 195 (locked)
Runtime # Fin (lorlead

File associations:

/A / == fault encodi q:
CUStO I I A —— D d .

extensions

Module 6
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Differences (4): Remote Support

+ Remote Fortran projects are not supported

4+ Basic features will work
(editor, Outline view, etc.)

+ Advanced features should not be enabled
(content assist, search, refactoring, etc.)

Module 6 6-25
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For More Information

+ Photran online documentation
linked from http://www.eclipse.org/photran

+ User’s Guide
General introduction, basic features

+ Advanced Features Guide
Features requiring analysis/refactoring to be enabled

+ Online tutorial: Compiling and running the
Parallel Ocean Program using Photran and PTP
linked from http://wiki.eclipse.org/PTP/photran/tutorials

Module 6 6-26



Refactoring

(making changes to source code that don’t affect the behavior of the program)

Refactor : Refactoring is the research
— motivation for Photran @ lllinois

lllinois is a leader in refactoring research

\X1{ 3 . . .
duce IMPLICIT NONE... Refactoring” was coined in our group
Introduce (Opdyke & Johnson, 1990)
Encapsulate var-av'--;“ We had the first dissertation...
: tity PUDIE- Opdyke, 1992
Make Prwata::se (o USE Statemen (Opdy _ ) _ _
Add ONL ONLY List T ...and built the first refactoring tool...
Minimizé Names Cons!s (Roberts, Brant, & Johnson, 1997)
MMON VarlablecoMM()N glock
Make = e variables t© ...and first supported the C preprocessor
Move LoopS unchecked =, (Garrido, 2005)
nge , .
interchd : Photran’s agenda: refactorings for HPC,
. or rators 4
unify K ' |ete OP°

language evolution, refactoring framework

Photran 6.0: 16 refactorings
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Rename Refactoring

(also available in C/C++)

+ Changes the name of a variable, function,

etc., including every use
(change is semantic, not textual, and can be workspace-wide)

+ Only proceeds if the new name will be legal

(aware of scoping rules, namespaces, etc.)

= C/C++ - MyHelloProject/src/MyHelloP1 + Select Fortran Perspective

Fle Edit Source Navigate Search Proje + Open a source fl|e
Rename... Shift+Alt+R

~ + Click in editor view on
declaration of a variable

+ Select menu item

(Debugging)

Refactor» Rename
Rename...
Extract F.r,.:;re \ + Or use context menu
Extract Local Variable... + Eﬂtel‘ new name

Module 6 6-28
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Extract Procedure Refactoring

(also available in C/C++ - “Extract Function™)

+ Moves statements into a new subroutine, replacing the
statements with a call to that subroutine

+ Local variables are passed as arguments

= Extract Procedure S=RAEl X )

gauselim.f30 - org.eclipse.photran-samples/src-gaussian-elimination

—— Swanll + Select a sequence of statements
O e TRy — | ored Source =l + Select menu item

- | Refactor » Extract Procedure...

+ Or use context menu

implicitc none

e ot e 0] I 4+ Enter new name
integer :: irow(10)

Module 6 6-29
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Introduce ImpLICIT NONE Refactoring

+ Fortran does not require variable declarations
(by default, names starting with I-N are integer variables; others are reals)

+ This adds an IMPLICIT NONE statement and adds explicit
variable declarations for all implicitly declared variables

= Introduce Implicit None E=NRE X

— + Introduce in a single file by

4 [V @2 Introduce Implicit None Opening the file and Selecting
V|5 gauselim.f90 - org.eclipse.photran-samples/src-gaussian-elimination Refacto r > I ntrod u Ce

Refactored Source I M P L I C I T N O N E e

program GaussianElimii =
implicit none
integer :: indx

integer :: jndx + Introduce in multiple files by

! SUBRCUTINES: mtxrd, mtxw integer :: kndx

R - :: o selecting them in the Fortran

v  Soive s 1incas oo Projects view, right-clicking on
i the selection, and choosing

Refactor » Introduce

IMPLICIT NONE...

[F] gauselim.fo0

Module 6 6-30



